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Processes can be represented by flowcharts, but they have one 
drawback – a standard flowchart cannot indicate who is responsible 
for the activities illustrated unless explanatory text boxes are added 
or unless sole responsibility for the entire process falls to one 
department. 

Instead, you can use a cross functional flowchart to portray the 
relationship between the steps in a process and the departments or 
functional areas that are responsible for those steps. 

In this session you will: 

 gain an understanding of cross functional flowcharts 

 learn how to create a cross functional flowchart 

 learn how to add swimlanes 

 learn how to add swimlane labels 

 learn how to add phases 

 learn how to add shapes 

 learn how to adjust swimlanes and phases 

 learn how to format cross functional charts. 

INFOCUS 
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UNDERSTANDING CROSS FUNCTIONAL FLOWCHARTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 

Cross functional flowcharts enable you to 
illustrate how a process flows between 
departments within an organisation. For example, 
you can depict how a new product is developed 

within the company, and how the different 
departments are involved in this process. The fact 
that you have two dimensions to a cross functional 
flowchart differentiates it from other flowcharts. 

2 

 The title bar appears at the top of the flowchart by default. 

 Each swimlane represents a different department or functional unit within an organisation which you can 

identify by modifying the label. The swimlanes can appear with a horizontal orientation (as they are 

above) where the steps tend to flow down and across through the flowchart or with a vertical orientation 

where the steps tend to move left and right in a horizontal manner.  

Note that a swimlane is a container that helps you to manage ordered sets of shapes. Like other 

containers in Visio, the swimlane and all shapes added to it are treated as a single unit – that is, if you 

move a swimlane, all shapes within it will also move. 

 The Connectors indicate the direction of the work flow. 

 Shapes from the Basic Flowchart Shapes stencil depict the steps of the process in a cross functional 

flowchart. 

 If you want to indicate phases in the process, you can use the Separator shape. This adds a heading in 

the phase bar and displays a separator through the swimlanes. 

 Built-in themes and styles can be applied to the flowchart or you can manually format the colour of each 

swimlane independently. In this case, we’ve applied the Module theme colours and Button theme 

effects to the flowchart but have retained the default style. 
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CREATING A CROSS FUNCTIONAL FLOWCHART 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Before starting this exercise 
ensure no files are open in Visio... 

 Click on the File tab, then 
click on Flowchart under 
Template Categories, click 
on Cross-Functional 
Flowchart and then click on 
[Create] 

A new default cross 
functional flowchart with two 
horizontal swimlanes, title 
bar and phase bar will be 
created.... 

 Click on the Cross-
Functional Flowchart tab 
to see the relevant 
commands 

 Click on Orientation  in 

the Arrange group and 
select Vertical 

The swimlanes will appear 
vertically on the page and 
their labels will move to the 
top of each swimlane. 

You can reverse the 
direction of the chart if 
desired… 

 Click on Direction  in the 

Arrange group and select 
Right to Left 

 Click on Undo  twice to 

reverse the Direction and 
Orientation 

 

For Your Reference… 

To create a cross functional flowchart: 
1. Select File > New > Flowchart > Cross 

Functional Flowchart 

Handy to Know… 

 You can choose whether to show or hide the 
title bar at the top of a cross functional 
flowchart. The title bar displays by default, 
but you can remove the tick from Show Title 

Bar in the Design group to hide the title bar. 

1 

4 

Visio includes a Cross Functional Flowchart 
template which lets you illustrate how a process 
(such as manufacturing a product) flows from 
start to finish and how the responsibility for the 

various steps flows through different functional 
units (such as departments in a company). You can 
select a vertical or horizontal orientation for the 
chart. 
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ADDING SWIMLANES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous 

file or open the file V516 
Cross Function_1.vsd... 

 Hover near a corner of a 
swimlane (at either end)  

A blue Insert Swimlane 
Shape icon  will appear and 
the swimlane border will 
change to a heavy orange 
line, showing where a new 
swimlane would be 
inserted… 

 Click on the blue icon  to 
insert a new swimlane 

Swimlanes are shapes and 
you can insert them from the 
Shapes window… 

 Drag the Swimlane shape 
over the last band in the 
flowchart 

 Release the mouse button to 
add another swimlane 

 Use either method to add 
another swimlane 

It’s very easy to delete 
unwanted swimlanes… 

 Click on the title of any 
swimlane  to select it – a 
selected swimlane appears 
with a pale orange dashed 
border – and press   

You should now have four 
swimlanes in the drawing 

 

For Your Reference… 

To add a swimlane: 

1. Hover over the corner of a swimlane, then 
click on the blue icon  to insert one below 

To delete a swimlane: 

1. Click on the swimlane label 

2. Press  

Handy to Know… 

 You can move a swimlane by dragging its 
label to a new location. 

 When you delete or move a swimlane in a 
cross functional flowchart, all shapes 
contained within that swimlane will also be 
deleted or moved. 

1 2 

Visio includes two swimlanes by default in a new 
cross functional flowchart. This is merely a 
starting point and you are able to quickly add 
swimlanes as you go. For instance, if three 

departments are involved in a process, then you’ll 
need to include three swimlanes in the chart to 
identify them. 

3 

4 
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ADDING SWIMLANE LABELS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the 

previous file or open V516 
Cross Function_2.vsd... 

 Double-click on the 
Function label in the top 
swimlane to select it 

 Type Sales 

The text field will appear 
horizontally so you can 
read what you are 
typing... 

 Double-click on the next 
label to select it, then type 
Production 

 Repeat step 3 to add the 
next two labels: 
Marketing and 
Administration, then 
press  

Let’s add the chart title 
now… 

 Double-click on the Title 
label at the top of the 
chart to select it 

 Type Developing a New 

Product, then press  

 

For Your Reference… 

To add text to a chart title or swimlane: 

1. Double-click on the flowchart title or 
swimlane label 

2. Type the text 

3. Press  

Handy to Know… 

 You can change the orientation of the 
swimlane label text from the default vertical 
to horizontal by clicking on Rotate Lane 
Label  in the Design group. To widen the 

label column to fit horizontal text, click on 
one of the labels to select it and then drag 
the right resizing handle to the desired width. 

1 

2 

Before adding shapes to a cross functional 
flowchart, you should identify which functional 
areas or departments each of the swimlanes 
represents. You can label each of the swimlanes 

by replacing the default Function text. You can do 
this by simply clicking on the label to select it and 
typing the desired text. You will also add the chart 
title during this exercise. 

3 
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ADDING PHASES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the 
previous file or open 
V516 Cross 
Function_3.vsd... 

 Click on Separator  in 

the Insert group to 
insert a separator half 
way along the chart 

 With the left hand phase 
selected (orange 
dashed border), repeat 
step 1 to insert another 
separator half way 
between the start and 
middle of the chart 

 Click on the third Phase 
label to select the last 
phase, then repeat step 
1 to create another 
phase 

Your chart should have 
four phases. Let’s edit 
the label text… 

 Double-click on the first 
phase’s label and type 
Research 

 Repeat step 4 to add the 
labels: Development, 
Testing and Release, 
then press  twice 

 

For Your Reference… 

To create a phase: 

1. Click on Separator  in the Insert group on 

the Cross-Functional Chart tab 

2. Double-click on the phase label, type the 
label and press  

Handy to Know… 

 Note: If you deselect Show Separators  in 

the Design group, your separators and 
phase names will be deleted. Clicking on 
Show Separators  again will not redisplay 

them. You must click on Undo  and select 

Show Separators to redisplay the phase 
details. 

1 

2 

A phase is used to indicate during which stage of 
the process a particular step will occur. For 
instance, the development process of a product 
could be divided into the phases of Research, 

Development, Testing and Release. On a 
horizontal cross functional flowchart, phases 
appear with a black vertical line (known as a 
separator) and phase label which you can edit. 

3 
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ADDING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    

Try This Yourself: 
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 Continue using the previous 

file or open V516 Cross 
Function_4.vsd... 

 Drag the Process shape as 
shown, then type Develop 
product specification  

 Drag the shapes as shown, 
typing the following text 
labels, and then use 
AutoConnect to connect 
the shapes 

Design & build product 
Acceptable? 
Develop marketing material 
Sell & deliver 

The first and last processes 
need to extend across 
multiple swimlanes. If you 
resized them earlier, Visio 
would have simply resized 
the swimlane which is not 
what we’re trying to 
portray… 

 Click on the first Process 
shape and resize it so that it 
extends across the Sales 
and Production swimlanes 

You might want to rearrange 
the connector… 

 Repeat step 3 to extend the 
final Process shape to 
extend over all four 
swimlanes 

 

For Your Reference… 

To add shapes: 

1. Drag the shape from the Shapes window 
into the desired swimlane and phase 

2. Use the AutoConnect mini toolbar to add 
connected shapes or add extra shapes from 

the Shapes window and then connect them 

Handy to Know… 

 When you click on a shape, the swimlane 
containing the shape will appear with an 
orange outline. If the swimlane is not 
highlighted (i.e. the shape is not contained in 
the swimlane), move the shape a little and 
the swimlane will recognise it. If you move 
the swimlane later, the shape will also move. 

1 

2 

You add shapes to a cross functional chart using 
the same methods that you use to create a basic 
flowchart. There is one difference, however. 
When you add a shape to a cross functional 

chart, Visio will automatically group the shape with 
the swimlane into which it is placed. If you want a 
shape to extend across swimlanes, you must resize 
it after connecting all shapes in the chart. 

4 
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ADJUSTING SWIMLANES AND PHASES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous 

file or open V516 Cross 
Function_5.vsd... 

 Click on the Production 
label to select the swimlane 

 Drag the bottom border until 
you reach the M for 
Marketing, then release the 
mouse button to enlarge the 
swimlane 

The Marketing process 
moved with the swimlane but 
the two resized shapes 
didn’t resize... 

 Extend the first and last 
process shapes to the 
bottom of Production and 
Administration respectively 

You can move a shape into 
a different swimlane… 

 Click on the process shape 
in Marketing and drag it up 
into Production, releasing 
the mouse button when 
Production is selected 

You can adjust the phases… 

 Click on the Research label 
to select the phase, then 
drag the right border to the 
left to make the phase 
narrower 

Notice that the width of the 
entire drawing will also 
reduce 

 

For Your Reference… 

To adjust the width of a swimlane or phase: 

1. Click on the swimlane or phase label 

2. Drag the border to extend or reduce the 
width 

Handy to Know… 

 To change the overall length of a cross 
functional flowchart, click on the title bar and 
drag the right or bottom central handle. You’ll 
move the chart if you drag a corner handle. 

 You can only adjust the width of a phase if 
there is room – e.g., you may need to move 
shapes before you can move a separator. 

2 

5 

You may find that the default width of the 
swimlanes and phases is not appropriate for your 
drawing. For instance, the label for a department 
may need the swimlane to be slightly wider to 

accommodate it. Similarly, specific phases of your 
process may include more steps than others so you 
may need to move the phase separators to fit the 
shapes. 
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FORMATTING CROSS FUNCTIONAL CHARTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous 

file or open V516 Cross 
Function_6.vsd... 

 Right-click on Sales, select 
Format > Fill, click on 
Accent 5 (row 1, col 10) in 
Fill Colour and click on 
[OK] 

Only the label will be filled… 

 Repeat step 1 to fill the other 
swimlanes as Accent1, 
Accent3 and Accent2 

Let’s fill the rest of the 
lanes… 

 Click on Style  in the 

Design group and click on 
Style with Fill 1 

You could fill the title and 
phase bars using the same 
method if desired, or you 
could apply a theme which 
will also apply colour and 
effects to the shapes… 

 Click on the Design tab then 
apply the Urban Colours, 
Bevel Highlight Effects 
theme 

Let’s format the text … 

 Format the: 

Title bar 14pt, bold 
Phase bar 10pt, bold 
Lane labels bold 
all text 10pt 

 

For Your Reference… 

To apply a style: 

1. Click on Style  in the Design group on 

the Cross-Functional Chart tab 

2. Click on the desired style 

To fill a swimlane: 

1. Right-click on a label and select Format > 
Fill 

Handy to Know… 

 You can insert a new page containing an 
empty cross-functional chart based on the 
current cross functional chart. This includes 
any formatting that you’ve applied such as 
text formatting, styles, themes and fills. 

 You can apply formatting to multiple lanes 
simultaneously by selecting them first. 

1 

5 

You can format cross functional charts as you do 
other drawings in Visio. You can fill shapes (e.g., 
if you work with several cross functional 
flowcharts it may be useful to fill swimlanes 

similarly to colour code departments), format text 
and apply themes to the entire drawing. You can 
also apply different styles to a cross functional 
chart which will further change its appearance. 

In this sample, we lengthened the Administration swimlane slightly to fit 
the label and we removed the text background from the connector text. 
To do this we clicked on the dialog box launcher  for Font and 

clicked on None under Text background on the Text Block tab. 
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NOTES: 
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